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Chapter 256

Multiple Comparisons
of Proportions for
Treatments vs. a
Control
Introduction
This module computes power and sample size for multiple comparisons of treatment proportions versus a control
proportion based on the results in Chow, Shao, and Wang (2008). In this design, there are k treatment groups and
one control group. A proportion is measured in each group. A total of k hypothesis tests are anticipated each
comparing a treatment group with the common control group using a simple z-test of the difference between two
proportions. The type I error rate is controlled using a Bonferroni adjustment.

Background
Whether you want to test several doses of a single treatment or several types of treatments, good research practice
requires that each treatment be compared with a control. For example, a popular three-arm design consists of three
groups: control, placebo, and treatment. Two tests are run: placebo versus control and treatment versus control. Of
course, you could design an experiment with four groups by having a separate control group for treatment and for
placebo. But it appears to be more efficient to use just one control group. Besides efficiency, it may be easier to
recruit subjects if their chances of receiving the new treatment are better than 50-50.

Technical Details
Suppose you need k treatment groups with response probabilities Pi that have samples of size Ni and one control
group with response probability PC that has a sample of size NC. The total sample size is N = N1 + N2 + … + Nk +
NC.
The hypotheses for two-sided tests are
H0i: Pi = PC versus Ha: Pi ≠ PC
For one-sided tests the hypotheses are
H0i: Pi ≤ PC versus Ha: Pi > PC
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Test Statistic
Chow, Shao, and Wang (2008) give the test procedure for each of the k two-sided comparisons as rejecting the
null hypothesis at the α level of significance if
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where z is the standard normal deviate. Dividing α by 2 in the above expression occurs because there are twosided tests. Dividing α by k in the above expression is used to make the Bonferroni adjustment so that the overall
significance level is α.

Power
The power of each test is
𝑃𝑃𝑖𝑖 − 𝑃𝑃𝑐𝑐

Power = Φ ⎛
where Φ(x) is the standard normal CDF.
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This formula can be rearranged to provide formulas for the sample size as well.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power or Sample Size.

Comparisons
Alternative Hypothesis
Specify whether a one-sided or two-sided test will be used.
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Power and Alpha
Power of Each Test
Enter the target power to be used for each comparison test. All comparisons use this same power. Power is the
probability of rejecting a false null hypothesis.
The valid range is 0 to 1. Usually, a power between 0.8 and 0.99 is desired. Different disciplines have different
standards for setting power. Common values are 0.80 and 0.90.
You can enter a single value such as 0.90 or a series of values such as 0.70 0.80 0.90 or 0.70 to 0.90 by 0.1.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.
Overall Alpha
Overall Alpha is the probability of rejecting at least one of the comparison hypothesis tests when the actual
proportion differences are all zero. Thus it is a combined alpha for the whole set of tests. The individual
comparison alphas are found using the Bonferroni adjustment.
Since Alpha is a probability, it is bounded by 0 and 1. Commonly, it is between 0.001 and 0.10. Alpha is often set
to 0.05.
You can enter a single value such as 0.05 or a series of values such as 0.05 0.10 0.15 or 0.05 to 0.15 by 0.01.
When a series of values is entered, PASS will generate a separate calculation result for each value of the series.

Sample Size (if solving for power)
Group Allocation
Select the method used to allocate subjects to groups. The choices are
•

Equal
All group sample sizes are the same. The common value of Ni is entered in the Ni (Group Sample Size) box
that appears immediately below this box.

•

Enter base group sample size and multipliers
The group sample sizes are found by multiplying the corresponding Sample Size Multiplier value by the Base
Group Sample Size that appears immediately below this box.

•

Enter N (total sample size) and group percentages of N
The group sample sizes are found by taking the corresponding percentage of the N (Total Sample Size) that
will appear immediately below this box.
Note that the Percent of N values are adjusted so they sum to 100%.

•

Enter individual group sample sizes
Enter each group's sample size directly in the corresponding Sample Size box below.

Ni (Group Sample Size)
This is the group sample size of all groups. One or more integer values, separated by blanks or commas, may be
entered. A separate analysis is performed for each value listed here.
You can enter integers greater than 5.
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Base Group Sample Size
This is the base sample size per group. One or more positive numbers, separated by blanks or commas, may be
entered. A separate analysis is performed for each value listed here.
The individual group samples sizes are determined by multiplying this value times the corresponding Sample Size
Multiplier value entered below in the Effect Size and Design section.
If the individual group Sample Size Multiplier numbers are represented by m1, m2, m3, ... and this value is
represented by Ni, the group sample sizes N1, N2, N3, ... are calculated as
N1 = [Ni(m1)]
N2 = [Ni(m2)]
N3 = [Ni(m3)]

where the operator, [X] means the next integer after X, e.g. [3.1]=4.
For example, suppose there are three groups and the multipliers are set to 1, 2, and 3. If Ni is 5, the resulting
group sample sizes will be 5, 10, and 15.
N (Total Sample Size)
This is the total sample size. The smallest value of N should be large enough to guarantee that all group sample
sizes are greater than five. The individual group samples sizes are determined by multiplying this value times the
corresponding Percentage of N value entered in the Effect Size and Design section below.
One or more values, separated by blanks or commas, may be entered. A separate analysis is performed for each
value listed here.
If the group percentage values are represented by Pct1, Pct2, Pct3, ... and this value is represented by N, the group
sample sizes are calculated as follows:
N1 = [N(Pct1)/100]
N2 = [N(Pct2)/100]
N3 = [N(Pct3)/100]

where the operator, [X] means the next integer after X, e.g. [3.1]=4.
For example, suppose there are three groups and the percentages are set to 25, 25, and 50. If N is 36, the resulting
group sample sizes will be 9, 9, and 18.

Sample Size (if solving for sample size)
Group Allocation Method
Select the method used to allocate subjects to groups during the search for the optimum sample size. The choices
are
•

Equal
The group sample sizes are constrained so that all group sample sizes are equal.

•

Equal (Fixed control group size with equal treatment group sizes)
The sample size of the control group is fixed by the user and the minimum sample size of the treatment
groups is found so that all target powers are met.

•

Unequal (Use sample size multipliers)
The minimum total sample size is found that uses the multipliers for each group.
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•

Unequal (Fixed control group size with flexible treatment group sizes)
The control group sample size is fixed by the user. The sample size for each treatment group is then found
such that its target power is just met.

•

Unequal (Find control size, then minimize treatment sizes)
First find the minimum control-group sample size that meets all target powers and uses the sample size
multipliers. Next, recalculate each treatment-group sample size using the minimum control-group size
individually, so that the target power is barely achieved.

•

Exploratory (Control group sizes can vary for each treatment group)
Exploratory. Does not provide an actual design configuration. Calculate the required sample size for each
control-treatment pair, using the sample size multipliers.

Control Group Size
Enter a fixed sample size for the control group. One or more positive numbers, separated by blanks or commas,
may be entered. A separate analysis is performed for each value listed here.

Effect Size and Design
Groups
Specify the number of groups given on this line. Usually, you will enter a "1" to specify a single group, or you
will enter a "0" to indicate that this line should be ignored. This option lets you easily specify many identical
groups with a single set of parameters.
The total number of groups is equal to the sum of these values.
Control Proportion
Specify one or more values of Pcontrol, the proportion of successes in the control group.
This parameter is used in the calculation of power as the actual value of this proportion and in the calculation of
the difference between the proportions to specify the effect size.
You can enter a single value such as 0.3 or a series of values such as 0.3 0.35 0.39 or 0.3 to 0.39 by 0.01.
Proportions must be between 0 and 1. They cannot take on the values 0 or 1. Also, Pcontrol cannot be equal to
any of the Pi.
Treatment Proportion
Specify one or more values of Pi, the proportion of successes on this treatment group.
This parameter is used in the calculation of power as the actual value of this proportion and in the calculation of
the difference between the treatment and control proportions to specify the effect size.
You can enter a single value such as 0.3 or a series of values such as 0.3 0.35 0.39 or 0.3 to 0.39 by 0.01.
Proportions must be between 0 and 1. They cannot take on the values 0 or 1. Also, Pi and Pcontrol cannot be
equal.
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Sample Size Multiplier
The definitions depends on whether you are solving for power or sample.
•

If solving for Power
The sample size for this group is equal to the product of this multiplier and the Base Group Sample Size
entered above. That is, the sample size for group i is given by Ni = (Base Group Sample Size) x (Sample Size
Multiplier). Hence, only the product of these two numbers is used.
Usage
There are a couple of ways to use these parameters.
First, you might enter as standard amount for the Base value such as ‘30’, and then enter a multiplier such as
'1' or ‘2’.
Second, you might enter the standard amount as the Multiplier and then enter the ratio as the Base amount.
For example, you might enter ‘50’ for the Multiplier and ‘1 1.5 2’ as the Base values.

•

If solving for Sample Size
The sample size for this group is equal to the product of this multiplier and an implicit base group sample size
that is found during the search. That is, the sample size for group i is given by Ni = Base x Multiplier. Hence,
only the product of these two numbers matters.

Percentage of N
This is the percentage of the total sample size that is allocated to this group. The individual group samples sizes
are determined by multiplying this value times the N (Total Sample Size) value entered above and then dividing
by 100. If the percentages do not sum to 100, they are rescaled so that they do. For example, the values 20, 20, 40
become 25, 25, 50 after rescaling.
For example, if these percentage values are represented by Pct1, Pct2, Pct3, ..., the group sample sizes are
calculated as follows:
N1 = [N(Pct1)/100]
N2 = [N(Pct2)/100]
N3 = [N(Pct3)/100]

where the operator, [X] means the next integer after X, e.g. [3.1]=4.
For example, suppose there are three groups and these percentages are set to 25, 25, and 50. If N is 36, the
resulting group sample sizes will be 9, 9, and 18.
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Example 1 – Finding the Sample Size
A parallel-group clinical trial is being designed to compare three doses of a test compound against the standard
therapy in patients with a specific type of disease. Suppose the standard therapy has a response rate of 60%. The
investigators would like a sample size large enough to find statistical significance at the 0.05 level if the actual
response rate is at least 70% and the power is 0.80 in each test. They also want to see the impact on sample size of
response rates of 75% and 80%. The tests will be two-sided.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Multiple Comparisons of Proportions for Treatments vs. a Control procedure window. You
may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Power of Each Test ................................ 0.8
Overall Alpha .......................................... 0.05
Group Allocation Method ........................ Equal
Control Proportion................................... 0.6
Set A Number of Groups ........................ 3
Set A Proportion ..................................... 0.7 0.75 0.8
Set B Number of Groups ........................ 0

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Hypothesis Type: Two-Sided
Number of Treatment Groups: 3
Group Allocation Search Algorithm: All groups have equal sample size

Comparison
Control
vs A1
vs A2
vs A3
Total

Target
Power
0.8000
0.8000
0.8000

Sample
Proportion
Size Proportion
Difference
Ni
Pi Pi - Pcontrol
472
0.6000
0.80085
472
0.7000
0.1000
0.80085
472
0.7000
0.1000
0.80085
472
0.7000
0.1000
1888
Actual
Power

Overall
Alpha

Bonferroni
Adjusted
Alpha

0.0500
0.0500
0.0500

0.016667
0.016667
0.016667

Control
vs A1
vs A2
vs A3
Total

0.8000
0.8000
0.8000

0.80020
0.80020
0.80020

199
199
199
199
796

0.6000
0.7500
0.7500
0.7500

0.1500
0.1500
0.1500

0.0500
0.0500
0.0500

0.016667
0.016667
0.016667

Control
vs A1
vs A2
vs A3
Total

0.8000
0.8000
0.8000

0.80133
0.80133
0.80133

105
105
105
105
420

0.6000
0.8000
0.8000
0.8000

0.2000
0.2000
0.2000

0.0500
0.0500
0.0500

0.016667
0.016667
0.016667
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Report Definitions
Comparison shows the test that is displayed on this line. Each treatment group is compared to the control group.
The null hypothesis, H0, is that the treatment group proportion is equal to the control group proportion.
The alternative hypothesis, Ha, is that the treatment group proportion is different from the control group
proportion.
Power is the probability of rejecting a false null hypothesis for this comparison.
Target Power is the power desired.
Actual Power is the power actually achieved.
Sample Size, Ni, is the number of subjects in the this group. The total sample size, N, is shown as the last row of
the set.
Proportion, Pi, is the proportion of successes in this group. These proportions are used in calculations involving
the alternative hypothesis.
Proportion Difference, Pi - Pcontrol, is the difference in the group proportions. When the actual proportion
difference is greater than this amount, the null hypothesis of equality will be rejected with probability equal
to the power.
Overall Alpha is the probability of rejecting at least one of the comparisons when the actual proportion
differences are all zero.
Bonferroni Adjusted Alpha is the significance level at which each individual comparison is made. It is calculated
by dividing the overall alpha by the number of treatment groups.
Summary Statements
A one-way study is planned to test whether each of 3 treatment-group proportions are
significantly different from the control-group proportion at the 0.0500 significance level. The
sample size of the control group is 472 and the sample sizes of the individual treatment groups
are 472, 472, and 472. Hence the total sample size is 1888. The corresponding powers of each of
the tests are 0.801, 0.801, and 0.801. These powers are computed assuming that the actual
control group proportion is 0.600 and the treatment group proportions are 0.700, 0.700, and 0.700.

This report shows the numeric results of this power study. Notice that the results are shown in blocks of three
rows at a time. Each block represents a single design.

Plots Section

This plot gives a visual presentation to the results in the Numeric Report. We can quickly see the impact on the
sample size of decreasing the difference between the treatment and control proportions.
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Example 2 – Validation using Chow, Shao, and Wang (2008)
Chow, Shao, and Wang (2008) page 100 gives an example in which the control response rate is 20%, treatment 1
response rate is 40%, and treatment 2 response rate is 50%. They use two-sided tests and set the overall
significance level at 0.05. They set the target power at 0.80. They calculate the sample sizes for treatment 1 as
about 95 and treatment 2 as about 45. Thus the required sample size is 95.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Multiple Comparisons of Proportions for Treatments vs. a Control procedure window. You
may then make the appropriate entries as listed below, or open Example 2 (a, b, or c) by going to the File menu
and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided
Power of Each Test ................................ 0.8
Overall Alpha .......................................... 0.05
Group Allocation Method ........................ Exploratory (Control group sizes can vary for each treatment group)
Control Proportion................................... 0.2
Control Multiplier ..................................... 1
Set A Number of Groups ........................ 1
Set A Proportion ..................................... 0.4
Set A Multiplier........................................ 1
Set B Number of Groups ........................ 1
Set B Proportion ..................................... 0.5
Set B Multiplier........................................ 1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Hypothesis Type: Two-Sided
Number of Treatment Groups: 3
Group Allocation Search Algorithm: EXPLORATORY, sample size of each comparison figured individually

Comparison
Control
vs A
vs B

Target
Power

Actual
Power

Sample
Size
Ni/Nctrl

0.8000
0.8000

0.80427
0.80687

96/96
44/44

Sample
Size
Multiplier
Mi
1.00
1.00
1.00

Proportion
Pi
0.2000
0.4000
0.5000

Proportion
Difference
Pi - Pcontrol

Overall
Alpha

Bonferroni
Adjusted
Alpha

0.2000
0.3000

0.0500
0.0500

0.025000
0.025000

PASS obtained 96 and 44 which matches Chow, Shao, and Wang’s results to within rounding. The final design
would be 96 subjects in each of the three groups.
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If you change the Group Allocation Method to Unequal (Use sample size multipliers), you will obtain the
following
Numeric Results
Hypothesis Type: Two-Sided
Number of Treatment Groups: 3
Group Allocation Search Algorithm: Unequal group sizes using sample size multipliers

Comparison
Control
vs A
vs B
Total

Target
Power

Actual
Power

0.8000
0.8000

0.80427
0.99059

Sample
Size
Ni
96
96
96
288

Sample
Size
Multiplier
Mi
1.00
1.00
1.00

Proportion
Pi
0.2000
0.4000
0.5000

Proportion
Difference
Pi - Pcontrol

Overall
Alpha

Bonferroni
Adjusted
Alpha

0.2000
0.3000

0.0500
0.0500

0.025000
0.025000

This algorithm first found the required group size of 96 and then provided the results when 96 is the common
group size. Notice that the actual power for the B vs Control comparison is 0.99059 which is much higher than
the target power of 0.80.
If you change the Group Allocation Method to Unequal (Find control size, then minimize treatment sizes), you
will obtain the following
Numeric Results
Hypothesis Type: Two-Sided
Number of Treatment Groups: 3
Group Allocation Search Algorithm: Unequal group sizes, first find minimum control-group size using multipliers

Comparison
Control
vs A
vs B
Total

Target
Power

Actual
Power

0.8000
0.8000

0.80157
0.81033

Sample
Size
Ni
96
95
33
224

Sample
Size
Multiplier
Mi
1.00
1.00
1.00

Proportion
Pi
0.2000
0.4000
0.5000

Proportion
Difference
Pi - Pcontrol

Overall
Alpha

Bonferroni
Adjusted
Alpha

0.2000
0.3000

0.0500
0.0500

0.025000
0.025000

This algorithm first found the required control group size of 96 and then provides the results when the target
powers are just met: 95 in treatment A and 33 in treatment B.
Notice that the actual powers are now close to the target powers. Also note that the total sample size has been
reduced from 288 to 224, a reduction of 22%.
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